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2 Document History

User Setup Guide

Document History
Version Date Changed by Description of changes
1.0 Nov 27, EFIS Team Initial Release
2014
1.1 Dec 11,2014 | EFIS Team Added ‘and Training’ to URL description
“NOTE: For UAT and Training user’s
only, use this URL:”
1.2 Dec 17,2014 | EFIS Team Removed “NOTE: For UAT and Training
user’s only, use this URL:” from pages
15, 25 and 34
1.3 Feb 11, 2015 | EFIS Team Removed reference to ‘Child Care’ /
‘Board User’ to make a generic Setup
Guide
1.5 Jul 15,2016 | EFIS Team Updated System Requirements,
Browsers and Smart View Setup
1.6 Aug 07, EFIS Team Removed reference to Calculation
2016 Manager and other updates based on
feedback
1.7 Aug 18, EFIS Team Removed reference to Calculation
2016 Manager and other updates based on
feedback
1.9 Aug 22, EFIS Team Fixed the URL for Firefox Portable
2016
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3 Description and System Requirements

3.1 Description

The following information describes the setup and configuration requirements that
need to be made to the end user workstation in order to use the Planning
application for EFIS 2.0 correctly.

In this ‘User Setup Guide’ you will find the detailed step-by-step instructions and

location of software needed:
e to setup and configure a supported browser (either Internet Explorer 9 + or

Firefox 47.01)
e to setup and configure the Smart View (Microsoft Excel Plug-In) software on

the end user workstation.
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3.2 User System Requirements

Client OS

Browsers

User Setup Guide

Exceptions and Additional
Info

Windows 7 (all SP levels
included)

Windows 8

Windows 8.1

Windows 10

Windows Server 2012 (all SP
levels included)/R2

Apple Max OS X Release 10.6.x

Internet Explorer 9.x,
Internet Explorer 10.x,
Internet Explorer 11.x,
Firefox 47.0.1

Internet Explorer 10.x,
Firefox 47.0.1

Internet Explorer 10.x,
Firefox 47.0.1

Internet Explorer 11.x,
Firefox 47.0.1

Internet Explorer 10.x,
Internet Explorer 11.x,
Firefox 47.0.1

Firefox 47.0.1

Preferred version for Firefox is
Firefox 47.0.1

Preferred version for Firefox is
Firefox 47.0.1

Preferred version for Firefox is
Firefox 47.0.1

Preferred version for Firefox is
Firefox 47.0.1

Preferred version for Firefox is
Firefox 47.0.1

Preferred version for Firefox is
Firefox 47.0.1

EXCEPTION: For Web browser
clients only.

Client Third Party Software

Vendor

Version

Exceptions and Additional
Info

Microsoft

Adobe
Adobe

Oracle

Office 2007 (all SP levels included)
Office 2010 (all SP levels included)
Office 2013 (all SP levels included)
Office 2016

Acrobat Reader 9+
Flash Player 10+

Smart View (v 11.1.2.5.520)

1. Certification Types: Office
Productivity Suite

2. For Offline Planning: MS Excel
and Offline Planning must be
installed on the same machine.

3. Office 365 editions require
locally installed supported
versions of Office applications. See
https://support.oracle.com/epmos

/faces/DocumentDisplay?id=1581
197.1.

Microsoft .Net Framework 4.5
required for Smart View.

1. *Chrome and Safari are not yet supported and should not be used.
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4 Firefox setup

4.1 Recommended Version

User Setup Guide

Firefox v47.0.1 regular is the recommend version for use with Oracle Hyperion

Planning.

4.2 Download File

The file can be downloaded from this URL:

https://efis.fma.csc.gov.on.ca/Firefox/FirefoxSetup47.0.1(English).zip

Click on “Save as”, to save related Firefox setup file to the folder of your choice.

& Save As
@n\‘;‘:v|l Desktop » - |¢? | | Search Desktop 2 |
Organize « Mew folder B= - I@l
- . -
4.0 Favorites |:| Tl
Ml Desktop -

4. Downloads

m

= Recent Places

4 Bl Desktop
4 Libraries
> 3 Documents
o J‘. Music -
- | 4| 1l 3

> &=l Pictures

File name{. Firefoxsetupd7.0.1(English).zip | -

Save as type: [Compressed (zipped) Folder (*zip) v]

“ Hide Folders [ Save Cancel ]

URL for Firefox (French version) is:
https: //efis.fma.csc.gov.on.ca/Firefox/FirefoxSetup47.0.1(French).zip

4.3 Download from Workspace

The file can also be downloaded from Explore at Hyperion Workspace:
e Loginto Hyperion Workspace.

e C(lickon icon from top ribbon.

e Click on “Firefox Regular” folder in “Shared Workspace Pages” folder from
left pane. You will find two Firefox installation (zipped) files - each of English

/ French versions in right pane.

P

age 6|36


https://efis.fma.csc.gov.on.ca/Firefox/FirefoxSetup47.0.1(English).zip
https://efis.fma.csc.gov.on.ca/Firefox/FirefoxSetup47.0.1(French).zip

Awaken Potential

The Learning Ministries

Enterprise Performance Management System Workspace, Fusion Edition
Mavigate File Edit WView Favorites Tools Help

® &

Pages/Firefox Regular *

ks E:q:ilcnrel m B ]

A K =

HomePage Expl /Shared Worksp

User Setup Guide

[£) Sample_Reports
[ Sample Content
> [f) 5G_Test
[£7 shared Workspace Pages
> [f EFIS2.0 GUI Downloz
[] Firefox Regular
[ FirefoxPortable
> [ TPREPORT |_|

Folders [Shared Workspace Pages/Firefox Regular
> [fJ 51415RES a0 13 Tune Modified Descrintion
> [f] S1516FIS ﬁﬁreﬁjx Setup 47.0.1 (English).zip  ZIP File 7/29/16 12:33FM I
» [[] 51516RES Firetox Setup 47.0.1 French).zip ZIP File 7/29/16 12:33PM

e Right click on your choice of Firefox Setup 47.0.1 (***).zip file and select
Open. It will open a new tab and a popup to download file.
e Select “Save File” and then click on OK to download Firefox install (zip) file.

Mavigate File WView Favorites Tools Help

2= Explore

A B =

HomeFage Explore: /Shared Workspace Pages Firefox Regular

[Shared Workspace Pages/Firefox Regular [Firefox Setup 47.0.1 (English).zip

(For convenience, you can save it to your desktop folder.)

Enterprise Performance Management System Workspace, Fusion Edition

Firefox Setup 47.0.1 (English).zip *

Opening Firefox Setup 47.0.1 (English).zip

You have chosen to open:
1, Firefox Setup 47.0.1 (English).zip
which is: Compressed (zipped) Folder

What should Firefox do with this file?

from:

) Dpen with [Windows Explorer (default)
|

| @ Save File |

[] Do this automatically for files like this from now on.

(g

e Unzip the file in order to prepare it for installation.
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4.4 Install Firefox

Once Firefox install files are downloaded (and unzipped), you will need to install
Firefox. (You may need to have Administrator rights to install Firefox. Please contact
your local IT support desk to provide the Administrator access.)
Double click on Firefox install (exe) file.

5 oot s . ==

Welcome to the Mozilla Firefox
Selup Wizard

Thig wizard will guide you through the instalation of Mozila
Firefoux.

Itis recommendad that you dose all other apglications
before starting Setup. This wil maloe it possible to update
redevant system fles without having to reboot your

computer.

Clidk Next to continue.,

iNEH‘t:» il Cancel

B )

Setup Type \
Choose setup opbions

Choase the type of setup you prefer, then dick Mext,

) Custom
You may dhoose individual options to be installed. Recommended for experienced users.

| =l

Page 8|36



[}
Al
{,@ User Setup Guide

Awaken Potential

The Learning Ministries

Ready to start installing Firefox

Firefos will be installed to the follewing location:

C:'Program Fies (x35)\Mozlla Frefox

Click Install to continue.

Compleling the Mozilla Firefox
Selup Wizard

Mozila Frefox hag been installed on your computer.

Clide Finish to dose this wizard.

Cancel

o After Firefox has finished installation, open Firefox if it has not launched
automatically
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| @ Mozilla Firefox Start Page %

User Setup Guide

(‘ € Fireion  Search or enter address

c !lq')'r:ard!

#8 8 A e O

I Q, search

mozilla

¥ ®* O F* O

Downloads Bookmarks Histary Add-ons Synec

Unlike your attic, Firefox is easy to clean, Just click the Forget Button
% and presto! Mo more browser history.

# @ Restore Previous Session
Options.

4.5 Allow pop-up windows

e (lick on “Open Menu”
e Select “Options”

e ¥ A O 9 =

Paste

Cut Mg Copy
- 10085 +

O = &

New Window  MNew Private Save Page
Window
s,
a 0 &
v
Print Hustery Full Screen

o

Options Add-ons
Open options
FuY

Jo
Fand

f

Developer Synced Tabs
€2 signin to Sync
Customize o o
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e (lick on "Content” tab on the left Panel

e Uncheck “Block pop-up windows’

/3 Optuoes ® |

)

User Setup Guide

| @ B

Content
DRM content
¥ | Play DEM content

Pop-ups
Block pop-up windows

@ = PROGO- EFIS [B) PPEEFS Workspage ¢ (A - BFIS | Documentation | | FaaEwWebste & Ty B

Fonts & Colors
Detault font:| Times New Roman = | Saze:| 16 X Advanced...
Colors...
Languages
Choose your preferred language for displaying pages Choose..
7z
—— —w e ———a —— —r ——a———

=y

4.6 Block Firefox Update and Requests

Firefox Menu Bar
e (Click on “Tools”->"Options”

File Edit View History Bookmarks [Tools| Help | EE——

’Nm Tab 4

4 - - "
SEQrCN OF ENTEY QOQOress

Downloads Ctrl+)

Add-ons Ctrl+Shift+ A

Apps
Set Up Sync...

Web Developer 2
Page Info

Options

e (lick on “Advanced” tab on the left Panel

e Under “Update” on the top

0 Select “Never check for updates...”
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Ble Edi Vew Higtory Bockmarks louks Help . ' . S e —— it ]
@ MosilaFelusSlart Page. % | 3% Uplians x |
& | U Fieto sbuutpreferencesFadvanced e O+ &R O @ =

B4 Mast Visited # Getting Started 5 Latest Headlines [ hteps//stage.cfinfma.... @ Megilla Firefox Stan Pa...

Automatically install updates (recommended: improved sacurity)

Warmn me if thi y add

o Advanced :
Qs
) General Data Cheices Network Update Certificates
= i
.& f Firefox updates:
=
&

Check for updates, but let me choose whether to install them
® ' Never check for updates (not recommended: security risk)

Show Update History

+ | Use a background service ta install updates

Automatically update:
| Search Engines

e Under “Certificates” on the top
0 Uncheck “Query OCSP responder servers to confirm the current validity
of certificates”

| 2% Oplions *® = B

-

&}
# @ Fertoe | aboutpreterencesfagvanced @ = PROG - EFS [ PPE SRS Workspace @ QA - EFIS || Oocumentation | | FaEwebste & fF o B

Advanced .

General Data Choices MNetwork Update Certificates

Requests

When a server requests my personal certilicate:
Select one automatically
8 Ask me every time

Query OCSP respander senvers to confirm the current validity of certificates

View Certificales Secunty Dewices

-~
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4.7 Adobe settings in Firefox

Firefox Menu Bar
e C(lick on “Tools”->"0Options”

User Setup Guide

File Edit View History Bookmarks [Tools| Help = —

’—New Tab =

=

Search or enter address

Downloads Ctrl+)

Add-ons Ctrl+5Shift+4

Apps
Set Up Sync...

Web Developer
Page Info

Options

e C(lick on “Applications” tab on the left Panel

e Make sure that everything under the Adobe Acrobat has “Use Adobe Acrobat (in

Firefox)”

Ble Edd View Hitory Buokmarks, Touls Help
@ Moaills Feela Start Page xlj"xx Options % |+

& | U Fiios abuutpreferences®applications

B Mast Visited @ Getting Started (o Latest Headlines ~ hittps//stage.cfis fma.... @ Morilla Firefos Start Pa...

m Applications
Qs
B o
A ap Content Type
. e P & irc
& s & o
€ s & mailio
B Padeast

A A

= Portable Document Format (POF)
B Video Podcast
B} web Feed

& webcal

- | Action

U Adways ask

H Always ask

3 Use Microsoft Outlook {default)
Y Preview in Firefax

& Use Adobe Acrobat (in Firelox)

' Preview in Firefox

Y Preview in Firefox

B Adways ask
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5 Firefox portable setup

5.1 Recommended Version

Firefox Portable v47 is the recommend version for use with Oracle Hyperion
Planning.

5.2 Download File

English version of Firefox Setup file can be downloaded from this URL:
https://efis.fma.csc.gov.on.ca/Firefox/FirefoxPortable47.0.1(English).zi

Opening FirefoxPortable 47.0.1zip N

You have chosen to open:

1, FirefoxPortable 47.0.1.zip
which is: Compressed (zipped) Folder (67.9 MB)

from: https://efis.fma.csc.gov.on.ca

What should Firefox do with this file?

() Open with [Windows Explorer (default) -

@) Save File

[ Do this autornatically for files like this from now on.

[ oK

(e

French version of Firefox Setup file can be downloaded from this URL:
https://efis.fma.csc.gov.on.ca/Firefox/FirefoxPortable47.0.1(French).zip

You can also find Firefox portable (English/French) files in Explore at Hyperion
Workspace:

e Loginto Hyperion Workspace

e C(lick on “Explore” from menu on top

e On left pane, Go to “Shared Workspace Pages”.
e Select “FirefoxPortable” folder

[} Shared Workspace Pages
» [[J EFISZ.0 GUI Download
["] Firefos Regular
I [ FirefoxPortable I
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e Selectrelated “FirefoxPortable 47.0.1 (***).zip on the right pane

Enterprise Performance Management System Workspace, Fusion Edition

Mavigate File Edit View Favorites Tools Help

A B & vopoe|m B oo B oo
HomePage Explore: [Shared Workspace Pages/FirefoxPortable *
Folders [Shared Workspace Pages/FirefoxPortable
[E7 Sample Content - T % Type Modified
[y 5G_Test I % FirefoxPortable 47.0.1.zip I ZIP File 8/9/16 1:03 PM
[J Shared Workspace Pages @ FirefoxPortable 47.0.1 (French).zip ZIP File 8/9/16 1:08 PM

@ [f] EFIS2.0 GUI Downloz
[ Firefox Regular
| FirefoxPortable

e Right click on file and select “Open”.
e File will open in new tab and popup will appear to open or Save the file. Select
“Save as” and save it (in a place of your choice)

F ki
@ Save As ﬁ

© "\ s =1 - - ~
bt j b Libraries » Documents » - |‘f|| Search Documents Pl
Organize * MNew folder 2 I@I
. .
7 Favorites H Documents library Arangeby: Folder +
Ml Desktop 7| Includes: 2 locations
& Downloads MName Date modif *
i-_"- Recent Places
J Smart View 07/29/2016|2
Bl Desktop i
- Libraries
3 Docurments
- My Documer -

| Public Docur ™ | Ul }

[FIEL Ml Fir=foxPortable 47.0.1 zip -

Save as type: lCompressed (zipped] Folder (*.zip) VI

=) Hide Folders [ swe || cancal |

Page 15|36



Awaken Potential

The Learning Ministries

5.3 Install Firefox

After download the file to your computer
e Rightclick on the file->Extract All

User Setup Guide

[C5C) » Downloads » Files »

Share with = Burn Mew folder
Mame : Date modified Type Size
i | FirefoxPortable ].?,ﬁ_]__zip O MM A0S BA  Cnminreccad f+inn £8 552 KB
Open

Open in new window
| 1
£ Extract All... J|

B Scanforthreats,..
glbapp-ﬂ'ﬁlzip B | EiEs it Kl

e Double click the folder FirefoxPortable 47.0.1-> FirefoxPortable
e Rightclick on the FirefoxPortable.exe file->"Create shortcut”

W App

. Data

. Other
FirefiPortabl

| @ FirefoxPortabl

4k | FirefoxPortabl
E-"j help

M LT AL LD F IV
07/19/2016 2:05 PM
07/19/2016 2:05 PM
07/19/201611:50 ...

Open
'@' Run as administrator
Troubleshoot compatibility
T-Zip »
CRC SHA »
[ Edit with Notepad++

Encrypt File with Password...

Encrypt File...

Digitally Sign File...

Encrypt and Digitally Sign File...
B Scan for threats...

Pin to Taskbar
Pin to Start Menu

Restore previous versions
Send to »

Cut
Copy

Create shortcut

Delete

e Move it to your desktop for easy access

rie aiaer
File folder
File folder

Windows Bat

.. Application

Cenfiguratio
HTML Docur
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5.4 Accessing EFIS 2.0

e C(lick on the Shortcut to open the browser
Once the browser opens it should look like the screen-shot below. Note the
following:

1. The home page is set to access EFIS 2.0, so once the browser it open, it should
go to the login page. User can also access EFIS 2.0 using the EFIS 2.0 Link
2. The documentation folder contains links to EFIS 2.0 documents on the FAAB
website. The three useful links here are:
a. Setup Guide - on how each user machine and browser should be
configured
b. Troubleshooting guide - to help with common issues a user might
experience in EFIS 2.0
c. User Guide - a guide on how to use EFIS 2.0

File Edit View History Bookmarks Tools Help

| @ Mozilla Firefox Start Page % | +

carch or enter

“ EFIS 2.0 Docurmentation @' FAAE Website

Please note: If you already have another version of Firefox installed on your
machine, please make sure that you are always opening this version for the
purposes of EFIS 2.0. This browser has all the necessary settings to run EFIS 2.0. If
you wish to set up another browser, please see the Setup Guide. Also note, if you
have another instance of Firefox open on your machine, and you follow the shortcut
to the EFIS 2.0 version of the browser, the browser which is already open will be
launched. The best way to know that you are in the EFIS 2.0 browser is by looking at
the links (bookmarks) next to the address bar.
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6 Internet Explorer setup

6.1 Recommended Version

Internet Explorer 9, 10 and 11 are the recommend versions for use with Oracle
Hyperion Planning.

6.2 IE Setup

Specific IE settings are recommended by Oracle for the Hyperion products.

6.2.1 “General” settings
e Open Internet Explorer
e Go to “Tools“->“Internet options“-> “General” tab
e In “Browsing history” section click on “Settings” button
e Select “Every time I visit the webpage” option

-~

Internet Opticns | ? & |

General |Security | Privacy I Content | Connections I Programs I Advanced|

Home page
l/’ To create home page tabs, type each address on its own line,
u
A http:/fintra.edu.gov.on.ca/ -
l Use current ] [ Use default ] [ Use new tab
Startup

() Start with tabs from the last session
@ Start with home page
Tabs

Change how webpages are displayed in tabs,

Browsing histary

Delete temparary files, history, cookies, saved passwords, and web
form information.

[] Delete browsing history on exit

| Delete.. || settings |

Appearance

Colors ][ Languages H Fonts H Accessibility ]

[ oK ][ Cancel ] Apply
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-

Website Data Settings

(2 )

Temporary Internet Files | History | Caches and databases |

Internet Explorer stores copies of webpages, images, and media

for faster viewing later.
Check for newer versions of stored pages:
(@ Every time I visit the webpage
(7 Every time I start Internet Explorer
(71 Automatically
(7 Never
Disk space to use (8-1024ME) 250
(Recommended: 50-250MB)

Current location:

C:\Users\AmaralA3\AppDataLocal{Microso ftWindows',
Temporary Internet Files),

[ Move folder... ][ View objects ][ View files

[ Ok, ] [ Cancel

Click “OK”->"Apply”

6.2.2 “Security” settings
e Select “Trusted sites” from “Select a zone to view or change security settings”

section
e C(lick on “Sites” button

-

Internet Options -

(2 [

General | Security |Pri1.racy I Content | Connections | Programs I .ﬂ.dvanced|

Select a zone to view or change security settings.

@ & v O

Internet Local intranet IOELEEIES  Restricted
sites

trust not to damage your computer or
your files,
You have websites in this zone,

L Security level for this zone

Custom

Custom settings.
- To change the settings, didk Custom level.

M
This zone contains websites that vou

-To use the recommended settings, dick Default level.

User Setup Guide
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In “Add this website to the zone:”, enter the following URL:

https://efis.fma.csc.gov.on.ca

User Setup Guide

Uncheck “ Require server verification (https:) for all sites in this zone

Click “Add”

N

Trusted sites

=

You can add and remove websites from this zone. All websites in

4 this zone will use the zone's security settings.

Add this website to the zone:

https://efis.fma.csc.gov.on.ca Add
Websites:

http: f/efis. fma. csc.gov.on.ca - Remove

http: ffintra. servicedesk.its.gov.on.ca

b s P e T e e T AT G bl it e e

-

http: ffintra. catalogue..its.gov.on.ca —
http:ffintra. projectcentre. csc.gov.on.ca b

|| Require server verification {https:) for all sites in this zone

Close

Repeat for the following URLS

0 https://www.lam.security.gov.on.ca

0 *.gov.on.ca

0 http://*.gov.on.ca

O https://*.gov.on.ca
Click "Close”->"Apply”
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e Select “Trusted sites”
e (lick on “Custom level” button
Internet Opticons | ? 2

|'\

General | Security |F‘ri'n.-'an::5.I | Content | Connections | Programs | Aduancedl

Select a zone to view or change security settings.

@ &« /v 0O

Internet Local intranet  Trusted sites  Restricted
sites

Trusted sites

V’ This zone contains websites that you Sites
¢ trust not to damage your computer or

your files,

You have websites in this zone.

Security level for this zone

Custom

Custom settings.
- To change the settings, dick Custom level.
-To use the recommended settings, didk Default level.

[ | Enable Protected Mode (requires restarting Internet Explorer)

| Customlevel... || Defaultlevel |

[ Reset all zones to default level ]

@ Some settings are managed by your system administrator,

[ Ok ] [ Cancel Apply

User Setup Guide
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¢ In the “Reset custom settings” section, from “Reset to:” list

0 Select “Low”

-

Security Settings - Trusted Sites Zone

Settings

(7) Enable

\#| Run ActiveX controls and plug-ins
(7) Administrator approved

) Disable
@ Enable
) Prompt

\#| Script ActiveX controls marked safe for scripting™
) Disable

) Prompt
|&? Downloads
._-ﬁ F_ile download
() Disable
@ Enable
|&? Font download

1 _Nieahla
4| 1 |

™

*Takes effect after you restart your computer

Reset custom settings

Reset to: ’Low(demﬂ v] [ Reset... l

Lo |

Cancel

)

User Setup Guide
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e In the “Settings” section

0 under “ActiveX controls and plug-ins”
= Enable “Run ActiveX controls and plug -ins”

User Setup Guide

= Enable “Script ActiveX controls marked safe for scripting*

-

Security Settings - Trusted Sites Zone 0.

e

Settings

|#| Run ActiveX controls and plug-ins
() Administrator approved
) Disable
@ Enable
©) Prompt
| @] Script ActiveX controls marked safe for scripting™
() Disable
@ Enable
©) Prompt
.g-ﬁ Downloads
@ﬁ File download
() Disable
@ Enable
,9‘% Font download
() Disable
(@) Ermszhla
4 | 1 |

*Takes effect after you restart your computer

Reset custom settings

Resetto: | Low (default) »| | Reset.. |

o |

Cancel

)
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e Under “Miscellaneous”
0 Enable “Access data sources across domains”
0 Enable “Allow script-initiated windows without size or position
constraints”
0 Enable “Display mixed content”

I N
Security Settings - Trusted Sites Zone | & |
Settings
|_| Miscellaneous -

|| Access data sources across domains
() Disable
@ Enable
©) Prompt

|_| Allow dragging of content between domains into separate wi
@ Disable
() Enable LM

] .Eillow dragging of content between domains into the same wi
@ Disable
) Enable

Il .ﬁllll::lw META REFRESH
() Disable
@ Enable

|_| Allow scripting of Microsoft web browser control
(T Dicshla i

1 | m | 3

( |

Security Settings - Trusted Sites Zone

Settings

|| Allow script-nitiated windows without size or position constrz «
(7)) Disable
@ Enable
|| Allow webpages to use restricted protocols for active conten
() Disable
(7) Enable
@ Prompt
__| Allow websites to open windows without address or status bi
() Disable K
(@ Enable W
|| Display mixed content
() Disable
@ Enable
) Prompt
|| Don't prompt for dient certificate selection when only one ce i

1 _Nicahla
4| m | 3

e (lick “OK"-> “Apply”
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6.2.3 “Privacy” settings
e Select “Privacy” tab
e Check "Turn on Pop-up Blocker"
e C(Click on “Settings” button next to “Turn on Pop-up Blocker” option
e In “Address of website to allow” add “*gov.on.ca” (to disable popup blocker
for EFIS Hyperion website)

i 5
Internet Opticns M
General I Security | Privacy |Cnr|tent I Connections | Programs | Advanced|

Settings

To set a standard privacy level instead of using custom
settings, dick the Default button. II

Custom

- Advanced or imported settings

[ Sites ] [ Import ] [ Advanced ] [ Default ]

Location
] Mever allow websites to request your Clear Sites
physical location
Pop-up Blocker
Turn on Pop-up Blodker Settings
ng
InPrivate

Dizable toolbars and extensions when InPrivate Browsing starts

Ok ][ Cancel H Apply ]
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r B
Pop-up Blocker Settings u

Exceptions

Pop-ups are currenthy blocked. You can allow pop-ups from specific
2 !l websites by adding the site to the list below.

Address of website to allow:

Add
Allowed sites:
“geca Remove
= srv 100 services ac.ca
“srv 105 services go.ca

webmail.ontario .ca

Maotifications and blocking level:

Play a sound when a pop-up is blocked.
Show MNotification bar when a pop-up is blocked.
Blocking level:

ll'u'ledium: Block most automatic pop-ups v]

Leam more about Pop-up Blogker

Click “Close”->"Apply”

User Setup Guide
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e C(Click “Advanced” button

0 Check the “Override automatic cookie handling”

User Setup Guide

= Select Accept for “First-party cookies” and “Third-party cookies”

= Check “Always allow session cookies” option

*= (lick “OK”

-
Internet Options

=)

General | Security | Privacy |Conter1t | Connections I Programs | A.dvanced|

Settings

settings, dick the Default button,
Custom

To set a standard privacy level instead of using custom

- Advanced or imported settings

[ Sites ] [ Import ] [ Advanced J [ Default ]
L |
Location
[ Mever allow websites to request your Clear Sites
physical location
Pop-up Blocker
Turn on Pop-up Blodker
InPrivate |
" Disable toolbars and extensions when InPrivate Browsing starts
|

L. QK ] [ Cancel Apply
P h
Advanced Privacy Settings s u

) You can choose how cookies are handled in the Intemet

Cookies
Ovemide automatic cookie handling

Always allow session cookies

= zone. This ovemides automatic cookie handling.

Third-party Cookies

First-party Cookies

@) Accept @) Accept
) Block (7 Block
() Prompt () Prompt

0K | | Cancsl
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6.2.4 “Advanced” settings

User Setup Guide

* Uncheck the option “Do not save Encrypted Pages to Disk”

e Select “Advanced” tab
e In the “Settings” section
0 Under “Security”
rInternetOptiuns - — @g1

| General I Security I Privacy I Content I Connections | Programs | Advanced [

Settings

f Reset Internet Explorer settings

Resets Internet Explorer's settings to their default
condition.

ﬁ Security
[7] allow active content from CDs to run on My Computer®
[7] allow active content to run in files on My Computer®
[7] allow software to run or install even if the signature is invi
Always send Do Mot Track header®
[ Block unsecured images with other mixed content
Check for publisher's certificate revocation
[ check for server certificate revacation™
Check for signatures on downloaded programs
[7] Do not save encrypted pages to disk
[”] Empty Temporary Internet Files folder when browser is de
Enable DOM Storage
Enable Integrated Windows Authentication™

[¥#] Enable memory protection to help mitigate online attacks
< | 1 | r

m

= v

*Takes effect after you restart your computer

[ Restore advanced settings ]

‘You should only use this if your browser is in an unusable state,

@ Some settings are managed by your system administrator.

[ QK ] [ Cancel Apply

Click “Apply”->"OK”
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7 Smart View

To use the Smart View add-in you must be using Microsoft Office 2007, 2010 or
2013.

You need to have Administrator rights to install Smart View. Please contact your
local IT support desk to provide the Administrator access.

Please note: If you have an older version of Smart View already installed on your
machine, please uninstall this version before proceeding with the install.

7.1 Download File
There are two methods of installing Smart View.

7.1.1 Method 1: From Within EFIS

Access the EFIS application as usual. Once you are signed in, click on ‘Tools’ ->
‘Install’ -> ‘Smart View’.
.*- acaindorsin . L '.-__L":—":_ o ‘

a |2 by D-acx | & Otacle Erteprive Pedfors
File Edn View Faveemes Tesk Help

x Google - 2 Search « - B thare | Meer 2

ORACLE

The following dialogue box will appear.

[@ QOracle Enterprise Performance Management System Workspace, Fusion Edition - Windows Internet Explorer mlglélg

Enterprise Performance Management System Workspace, Fusion Edition Logged in as Help Log Off o

Navigate File View Favorites Tools Help
A B = - bBqpoe

_—
HomePage * © Advanced
Il /shared worksg
el Do 0w want to run or save SmartView.exe (124 MB) from intra.dev.fm ov.on.ca? —
9 ¢
@ This type of file could harm your computer. Run Save |7 Cancel .
@ #100% v

Click on ‘Run’ to install the software now or ‘Save’ to save the program and install
later. Follow the next steps to complete the installation.

Page 29|36



-]
A
C—/j.:B User Setup Guide

Awaken Potential
Ministries

The Learning

Smart View Installation

Initiate the Smart View install by navigating to the folder where you downloaded
the file and then double clicking the SmartView.exe file.

Oracle Smart View for Office Installation u

Select destination folder for Oracle Smart View

Ch\Oracle\3martView D

| oKk || cancel |

e Select your destination folder and, click OK.
e Follow prompts to complete Smart View installation.

7.1.2 Method 2 - For Ministry only:
Get Help Desk to install the Radia package CSC_ORC_SMRTVW_11X20_01

7.2 Verify the installation
The next step is to open Excel and check that the Smart View Tab is visible in
toolbar.

| ™ = Bookl - Microsoft Excel
m_ Home Insert Page Layout Formulas Data Review View Smart View
S ndo EEy Copy Data Point = = -
:I - ) undo | [y Copy Data Point @ @ g= Trer
o & Redo i Paste Data Point i ‘J__ & Sheet Info
Panel | Connections . Refresh ' Submit = Options _
- Zl| Functions = - Data B More *
Start Edit Data General

n - £
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7.3 Language selection for Smart View

x|
Member Options % Change global Smart View options. =
Data Options —~
Op General L)
l Advanced ] Shared Connections URL: | C:\Users\garicst\Documents\Smart \ﬁew‘l,Smart\ﬁ| -
] MNumber of Undo Actions q t‘
Formatting =
i [
cat st MNumber of Most Recently Used items _—
es
Delete All MRU Items |
Extensions Logging
Log Message Display Extended Info | -
Route Messages to File C:\Users\garicst\Documents\Smart View'\Smart View| ...

O clear Log File on Next Launch
Show Diagnostics Group on Smart View Ribbon

. 0
| Language English -
STaul

[ pisplay Smart View Shortcut Menus Onily

[ pisable Smart View in Qutiook Arahic

7.4 Setting up the connection

In Smart View, go to Options, Click on Advanced and specify the shared
Connections URL:

https://efis.fma.csc.gov.on.ca/workspace/SmartViewProviders
Options —_ﬁ’ ""P—“ T i)

Member Options I% Change global Smart View options. Il
Data Options g
on! General T
Advanced I Shared Connections URL: https:/fefis.fma.csc.gov.on.ca/workspace fsmar
) Mumber of Undo Actions T i
Formatting =
Mumber of Most Recently Used items H
Cell Styles
[ Delete All MRU Items ]
Extensions Logging ()
Log Message Display [Errors v]
"] Route Messages to File | C:\Wsers\gandhimAppData\RoamingOrade '.,Srnart'u'|
Clear Log File on Next Launch
[T Enzhle Brafilinn fda this anke b @nnaek sraineer recmmmendzton 3
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7.5 Setting up the Options in Smart View
To access the Options click on Smart View - Options

0~ = T oK™ crosor v

User Setup Guide

View Developer Add-Ins

Help -
Sheet Info

“_ Home Insert Page Layout Formulas Data Review

=i - ) Undo a Paint @ @
‘_'fh @ Redo e Data Point .

Panel Connections Refresh | Submit

- Functions ~ - Data
Start Edit Data

3
a

-
Under Data Options remove the check marks from following boxes under Suppress

Rows and Columns.

e No Data/Missing

e Zero

e No Access

e Suppress Missing blocks

Under Replacement, make sure that the #NoData/Missing Label is blank

Member Options E =
Suppress Rows

O mo Data f Missing

D Zero

D Mo Access

O 1rvalid

O underscore Characters

l Data Options l

Advanced
Formatting
Cell Styles
Extensions
[0 repeated Members
Suppress Columns
O o Data f Missing
O zere

O o Access (t)

Replacement
#MNoDataMissing Label:

#MoAccess Label:
#Invalid/Meaningless:
O submit zero
O oisplay Invalid Data
Enable Essbase Format String
Mode
Cell Display
[ navigate without Data
I O suppress Missing blacks I

Change Smart View options related to grid rows and columns.

| v

#Mo Access

#Invalid

Data
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Under the Formatting Tab, make sure that “Adjust Column Width” is checked off

oprons x|
Member Options 1= . Change grid formatting, styling and coloring options.
Data Options ing -:.
Advanced [ use Thousands Separator
Formatting & Use Cell Styles
O Use Excel Formatting
el Styles D Mowe Formatting on Operations
Extensions O retain Mumeric Formatting
djust Column dith
Scale |Default | - |
Preview | |
Decimal Places |Default | - |
Preview | |
Form (i)
[ Repeat Member Labels
After you make changes if any, click on the arrow beside OK and select “Save as
Default options”.
oveons — x

Member Options
Data Options

Advanced

Formatting

Cell Styles

Extensions

Help

Reset

‘j Change grid formatting, styling and coloring options.

Formatting
[ vuse Thousands Separator
() Use Cell Styles
(O Use Excel Formatting
D Mowe Formatting on Operations
D Retain Numeric Farmatting
Adjust Column width

Scale | Default
Preview |
Dedmal Places | Default
Preview |

Form

[ repeat Member Labels

ﬁl Cancel

Save as Default Options

Apply to All Sheets
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Close Excel and reopen. Check all changes done in Smart View Options were saved.

Connect to the EFIS system.

e (lick on “Smart View”->"Panel”->"Shared Connections”

D™=

Home Insert

) Undo Copy

L'E?" & Redo Paste

Connections

Page Layout Formulas Data Eeview View

Refresh | Submit | Options

Book3 - Microsoft Excel

Developer
= - e - -

@ @ E= @ Halp I2f, start Diagnostics
o=

|§' Sheet Info [;7) Clear Diagnostics Folder

(= IR R AR S I

e Enter your credentials
e C(lick on “Sign In” button

- Fundtions = - Data El More - Take Screenshot
Start Edit Data General Diagre
Al - [ 5|
A B c D E F = | Smart View

Smart View Home

v Shared Connections
Connections from shared repository

B Private Connections
Locally defined connections and short

Lagin u
——— -
-~
GO Secure 1D :
Or, if you have a PKI cerificate:
Password o
| " Log in with PKI
| Signin |
Forgot your ID or password ?
Don't have a GO Secure account? Register =
Now.
© QUEEN'S PRINTER FOR ONTARIO, 2012-13 | ENV ID: UAT
LAST MODIFIED: 2016-04-07 12:27:20
s
4 T | b
Cancel
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In the dropdown, Select “Oracle Hyperion Planning, Fusion Edition”
Click on the “+” sign beside “stage.efis.fma.csc.gov.on.ca

Click on the “+” sign beside the doc set you will work on

Click on the “+” sign beside “Task Lists”

Double click on the Task List you will input data

Smart View v 2

| » i

Shared Connections a4 -~ »

Orade® Hyperion Planning, Fusion Editon + =2 =

»

- [E] stage.efis.fma.csc.gov.on.ca

- S1314EST
- @ 51516RES
-] Forms
=[] Task Lists
----- Submission Input and Query - Mon-F
----- Submission Input and Query - FS_Sc) £
----- Data Refresh - DSE_Mise & jour de ¢
----- Data Refresh - Ministry_Mise a jour
----- Submission Management - Modifier
----- Submission Management - Approver,
----- Submission Management - FO_Gesti]
----- Administrator _Administrateur
----- Syrian Mewcomer Adjustments_A no
----- Revised Estimates - V10W - BE7059
----- Estimates - V10W - B67008
-y EDUMaIn
-\ EDUDH
- \# EDUFS

51415EG1

51415MAR.

MetaDT2

TRAIN1

P1516EST

=1-..[=].
[y i )

=l
()

e OO o O o OO O
A uEs
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7.6 Changing Windows registry settings to fix timeout issues

Smart View users who perform large requests or have a slow network connection
can encounter the error, "The request timed out. Contact administrator to increase
NetRetryCount and NetRetryInterval.”

When the server requires time longer than the time-out limit to return data to the
browser because of the large amount of data, the time-out error will be displayed.

This issue is resolved by updating registry settings on the user’s workstation to
increase the timeout settings.

On the client machine, update/add the following registry keys:
1. Open the Registry, Start -> Run -> Regedit

2. For client machine with Win 64-bit with Office 64-bit or Win 32-bit with
Office 32-bit, locate the following section:

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\ CurrentVersion
\Internet Settings

Create the following new DWORD keys with decimal values:
ReceiveTimeout 1800000

KeepAliveTimeout 1800000

ServerInfoTimeout 1800000

3. Ifyou run Win 64-bit with Office 32-bit, locate the following section:

HKEY_LOCAL_MACHINE\Software\WOW6432Node\Microsoft\Windows
\CurrentVersion\Internet Settings

Create the following new DWORD keys with decimal values:
ReceiveTimeout 1800000

KeepAliveTimeout 1800000

ServerInfoTimeout 1800000

These changes result in the timeout settings being increased to 30 min.
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